**Notes:**

1. Avoid placing lane closure tapers within or immediately following horizontal & vertical curves by adjusting longitudinal buffer space.

2. If longitudinal buffer space is reduced from distances listed in Table, upgrade protective vehicle to a transportable attenuator.

3. 28" traffic cones recommended. 36" tall channelization devices, or traffic safety drums may also be used.

4. Flaggers may be combined with alternating vehicular traffic. Bikes to be combined with alternating vehicular traffic.

5. Accumulate pedestrian/visual lane closure using the paved shoulder opposite the work area, or another method the engineer accepts.

6. See standard specifications for additional requirements.

7. For project-specific requirements, see special provisions.

8. Afad gate arm shall reach halfway across lane being controlled on red light display & ascend to an upright position on flashing yellow lens display, gate arm shall not descend until after red lens is displayed.

9. Flaggers shall be trained in operation of afad flagger and alternating traffic control devices, or traffic safety drums may also be used.

10. Signs are black on orange unless otherwise indicated.

11. Actual centerline pavement markings may vary.


TYPICAL TRAFFIC CONTROL PLANS

ALTERNATING 1-LANE, 2-WAY TRAFFIC: AFAD-CONTROLLED (45+ MPH HIGHWAYS)

NOT TO SCALE

UNIGNALIZED INTERSECTING ROADWAY DETAIL
SAME SIDE AS LANE CLOSURE (TWO OPEN LANES)

UNIGNALIZED INTERSECTING ROADWAY DETAIL
SAME SIDE AS LANE CLOSURE (SINGLE OPEN LANE)

DRIVEWAY OR BUSINESS ACCESS DETAIL
SAME SIDE AS LANE CLOSURE

NOTE 13
SEE NOTE 13

NOTE 14
(OPTIONAL)
SEE NOTE 14

NOTE 15
SEE NOTE 15

NOTE 16
SEE NOTE 16

12. FOR LEGEND, TABLES, AND ADDITIONAL NOTES SEE TC330, SHEET 1

13. WORK MAY OCCUR ACROSS INTERSECTING ROADWAY APPROACH BY HOLDING ACCESS TRAFFIC UP TO 5 MINUTES AND Restricting TURNS FROM MAINLINE. CHANNELIZATION DEVICES DELINEATING Approach MAY BE REMOVED.

14. SINGLE FLAGGER MAY BE ADDED TO THE INTERSECTING ROADWAY APPROACH TO HELP GUIDE ALTERNATING TRAFFIC THROUGH INTERSECTION.

15. WORK MAY OCCUR ACROSS DRIVEWAY OR ACCESS APPROACH BY HOLDING ACCESS TRAFFIC UP TO 5 MINUTES AND Restricting TURNS FROM MAINLINE. CHANNELIZATION DEVICES DELINEATING ACCESS MAY BE REMOVED.

16. PAVEMENT MARKINGS MAY VARY.

NOTE 10
(OPTIONAL IF 40 MPH OR LESS)

NOTE 11
SPACING 5'

NOTE 12
SPACING 5' DEVICE

NOTE 13
SEE NOTE 13

NOTE 14
(OPTIONAL)
SEE NOTE 14

NOTE 15
SEE NOTE 15

NOTE 16
SEE NOTE 16

W20-1
MIN 36”

W20-4
MIN 36”

W20-7A
MIN 36”

W20-7B
MIN 36”

W21-1401 (W/R, B/O)

LAGGER PADDLE

NOTE 10
(80 x 80) signs required on 45+ mph roadways

NOTE 11
SPACING 5’

NOTE 12
SPACING 5’ DEVICE

NOTE 13
SEE NOTE 13

NOTE 14
(OPTIONAL)
SEE NOTE 14

NOTE 15
SEE NOTE 15

NOTE 16
SEE NOTE 16

16. PAVEMENT MARKINGS MAY VARY.
NOTES:

1. AVOID PLACING LANE CLOSURE TAPERS WITHIN OR IMMEDIATELY FOLLOWING HORIZONTAL & VERTICAL CURVES BY ADJUSTING LONGITUDINAL BUFFER SPACE.

2. IF LONGITUDINAL BUFFER SPACE IS REDUCED FROM DISTANCES LISTED IN TABLE, UPGRADE PROTECTIVE VEHICLE TO A TRANSPORTABLE ATTENUATOR.

3. 28" TRAFFIC CONES RECOMMENDED. 36" TRAFFIC CONES, 42" TALL CHANNELIZATION DEVICES, OR TRAFFIC SAFETY DRUMS MAY ALSO BE USED.

4. BICYCLISTS MAY BE COMBINED WITH ALTERNATING VEHICULAR TRAFFIC BIKES TO CLEAR PRIOR TO FLAGGERS RELEASING ONCOMING TRAFFIC.

5. ACCOMMEDIATE PEDESTRIANS VIA SHUTTLE THROUGH LANE CLOSURE, USE THE PAVED SHOULDER, USE THE WORK AREA, OR ANOTHER METHOD THE ENGINEER ACCEPTS.

6. SEE STANDARD SPECIFICATIONS FOR ADDITIONAL REQUIREMENTS.

7. FOR PROJECT-SPECIFIC REQUIREMENTS, SEE SPECIAL PROVISIONS.

8. AFAD GATE ARM SHALL REACH FULLY RETROREFLECTIVE ON WORK AREA WITH ALTERNATING/WAITING, STREET FLASHERS OR, IF NOT SPECIFIED DISTANCES REQUIRED, STRATEGICALLY POSITION WORK VEHICLE TO PROTECT WORK CREW.

9. FLASHERS SHALL BE TRAINED IN OPERATION OF AFAD. FLAGGER SHALL BE POSITIONED TO SEE BOTH AFAD AND APPROACHING TRAFFIC (DIGITAL ALTERNATIVES ARE RECOMMENDED). HOST VEHICLE WEIGHT 22,001+ lbs.

10. SIGNS ARE BLACK ON WHITE UNLESS OTHERWISE INDICATED.

11. ACTUAL CENTERLINE PAINT MARKINGS MAY VARY.

**ALTERNATING 1-LANE, 2-WAY TRAFFIC: AFAD-CONTROLLED**

(45+ MPH HIGHWAYS)

**NOT TO SCALE**

**TYPICAL TRAFFIC CONTROL PLANS**

**Department of Transportation**

**Washington State**

**STATIONARY TRANSPORTABLE ATTENUATOR**

ROLL AHEAD DISTANCE = R

**AFAD GATE ARM DETAIL**

PREPARED TO STOP

 preparation to stop

STOP ARM SHALL BE FULLY RETROREFLECTIVE ON WORK AREA WITH ALTERNATING/Waiting, STREET FLASHERS OR, IF NOT SPECIFIED DISTANCES REQUIRED, STRATEGICALLY POSITION WORK VEHICLE TO PROTECT WORK CREW.

**AFAD RED/YELLOW LENS DETAIL**

**LEGEND:**

- **TEMPORARY SIGN LOCATION**

- **28" REFLECTIVE TRAFFIC CONE (SEE NOTE 2)**

- **OPTIONAL CHANNELIZATION DEVICE**

- **PROTECTIVE VEHICLE (SEE NOTE 2)**

- **FLAGGER**

- **AUTOMATED FLAGGER ASSISTANCE DEVICE (SEE NOTES 6 & 7)**

**REGIONAL ADM.**

**DATE OF REV.**

**FILE NAME:**

**DATE:**

**TIME:**

**PREPARED BY:**

**DRAWN BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REVISION:**

**PLOTTED BY:**

**ENTRANT:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**

**FILE NAME:**

**PREPARED BY:**

**CHECKED BY:**

**DESIGNED BY:**

**REGIONAL ADM.**

**DATE:**
NOTES:

12. For legend, tables, and additional notes see TC330, Sheet 1

13. Work may occur across intersecting roadway approach by holding access traffic up to 5 minutes and restricting turns from mainline channelization devices delineating approach may be removed.

14. Single flagger may be added to the intersecting roadway approach to help guide alternating traffic through intersection.

15. Work may occur across driveway or access approach by holding access traffic up to 5 minutes and restricting turns from mainline channelization devices delineating access may be removed.

16. Pavement markings may vary.

ALTERNATING 1-LANE, 2-WAY TRAFFIC: AFAD-CONTROLLED (45+ MPH HIGHWAYS) NOT TO SCALE

Washington State Department of Transportation

TYPICAL TRAFFIC CONTROL PLANS

FILE NAME: Sheet330.dgn

DATE: 7/20/2022

TIME: 12:54:45 PM

TYP: P

DFN Ai: Proj No.

PLOT: Yes

PLOT BY: Lintz

DESIGNED BY: Halapa & Lintz

ENTERED BY: Lintz

CHECKED BY: Halapa

REGIONAL ADMIN.

REVISION DATE: 2/10/2022
IMPORTANT: An extensive library of updated work zone cells are now available for work zone signs, detour signs (generic and route-specific), tables, legend, and symbols. Use these updated cells in all traffic control plans; at minimum, replace all work zone tables in all traffic control plans. This Typical Traffic Control Plan has updated cells (as of July 2022) already incorporated, but some cells have been modified.


WSDOT Staff
(1) Cell libraries are automatically updated by CAE
(2) Manually update or replace Microstation cells at least annually. For technical support and guidance see https://wsdot.wa.gov/engineering-standards/design-topics/engineering-applications/technical-support-guidance

External Cells (e.g. Local Agencies, Design-Rafid Contractors, and Consultants):
(1) Manually install updated WSDOT cell libraries into Microstation. For download and installation instructions see https://wsdot.wa.gov/engineering-standards/design-topics/engineering-applications/software-resource-updates
(2) Manually update or replace Microstation cells at least annually. For technical support and guidance see https://wsdot.wa.gov/engineering-standards/design-topics/engineering-applications/technical-support-guidance

PRINTING IN FULL COLOR OR GRAYSCALE (BLACK/WHITE):
Even though the work zone cells are full color, CAE has programmed Colors 224-239 (used for the work zone cells and the centerline) to print in grayscale automatically when designers print in black/white.

For this to function properly (otherwise it will print out as a solid black grid); DESIGNERS MUST FIRST UPDATE THEIR COLOR TABLE AND THEN REPLACE THE OLD WORK ZONE CELLS (or Update if the new work zone cells are already used).

1. Update color table by selecting File -> Default color table. In the Color table, select File -> Default color and Close.
2. Replace the old work zone cells using the Replace Cells Icon command. Select Tools -> Cells -> Replace Cells. Set the Method to Replace and either:
   - Single or Global mode (Single will just replace that one cell, Global replaces all cells matching the selected cell's name). Then select the cell to replace and accept it.

For additional information email HCA4HelpDesk@wsdot.wa.gov.

TYPICAL TCP USAGE EXPLANATION:

**Plot 1:** AFAD-controlled 1-lane, 2-way alternating traffic on 45+ mph 2-lane highways unsurfaced within the existing open lane up to 1000′ +/- maximum between mainline flaggers and up to 2 driveway, business access, and/or intersecting roadways.
- To shift open lane over onto shoulder, see TC33
- For temporary traffic management strips, see TC332
- When mainline AFADs are separated more than 1000 feet or when 3+ driveway, business access, and/or intersecting roadways are present, see TC333 (Plot Car Operation TCP)
- For corridors with high volumes (exceeding 800 vehicles/hour in all directions), contact Region Traffic Operations to determine if the High-Volume Traffic (Version 2500) should be used.
- For AFAD-controlled traffic through unsignalized intersections, see TC336
- For AFAD-controlled traffic through signalized intersections, see TC337
- For AFAD-controlled traffic through roundabouts, see TC338
- If not published yet, they will be added in the future.

**Plot 2:** Details for intersecting roadways and roadway/business access for Plot 1.
- When 3+ driveway, business access, and/or intersecting roadways are present, use TC333 (Plot Car Operation TCP)

**Other Alternating Traffic TCPs (45+ mph):** See Typical Traffic Control Plan Library

**Other Alternating Traffic TCPs (40 mph or less):** See Typical Traffic Control Plan Library

**DESIGNER NOTES:**
A. Contact Region Traffic Operations to determine which Typical TCP(s) to utilize, as there are several variations available (or soon will be).
B. These typical traffic control plans may be modified for site specific situations and/or WSDOT Region Traffic Operations standards practiced.

**Typical TCPs are not "Standard Plans".**
C. See MUTCD Table 6-1 for additional temporary sign size information. Work zone signs are usually smaller than those used permanently.
D. WAC 468-95-360 modifies MUTCD Table 6-1 "Recommended Advance Warning Sign Minimum Spacing". Sign spacing may be adjusted for field conditions based on engineering judgment. The Sign Spacing table is acceptable to use in Typical TCPs; however, site-specific traffic control plans should include actual sign spacing values (+/-) that have been verified in the field, on SR view, or via Google Maps.
E. When positioned behind channelization devices, temporary signs should be mounted at 5′ minimum.
F. The work zone design speed is typically the posted speed limit (or the work zone speed limit when in effect). For split speed limits (SPEED LIMIT 65 TRUCKS 80), use the higher 65 mph for work zone design. For this Typical TCP, the work zone design speed is based on the existing posted speed limit for sign spacing, channelization device spacing, buffer, and roll ahead distances.
G. "Flagger tapers", also used for AFADs, are always 50′-100′ per closed lane with 6 vehicles minimum (10′-20′ spacing on the taper), regardless of the posted speed limit or lane width per MUTCD 6.10.2, Paragraph 15. Never use "L" for these tapers.
H. Channelization devices types may be modified (vertical panel channelization devices prohibited). 26′ reflective traffic cones are recommended on flagger-controlled alternating traffic to provide access identification to maintain visibility for turning motorists. 36′ reflective traffic cones, 42′ tall channelization devices, or traffic safety drums may be used. Warning lights on channelization devices is being phased out in Washington. Contact Region Traffic Operations for information regarding their standard practices.
I. Maximum channelization devices spacing table for tangents is based on WAC 468-95-301 and may always be reduced.
J. Sequential arrow boards are prohibited at flagger tapers per WSDOT standard practice and per MUTCD Guidance TA-10.
K. Per MUTCD Section GC.06, longitudinal buffer spaces are optional. Using longitudinal buffer spaces listed in MUTCD Table GC.2 is recommended as best practice per feasible, but may be adjusted based on engineering judgement. The Longitudinal Buffer Space table is acceptable in Typical TCPs; however, all-specific traffic control plans should include actual buffer distances that have been verified in the field, on SR view, or via Google Maps.
L. The lateral buffer (transverse distance between open travel lanes and work area) is optional. No lateral buffer has been provided in these Typical TCPs due to the low speeds of alternating traffic. Actual work area limits may be modified.
M. WSDOT best practice is to place a protective vehicle (PV) in the closed lane in advance of the work area for flagger-controlled alternating traffic, but if not published yet, they will be added in the future.
N. When positioned behind channelization devices, temporary signs should be mounted at 5′ minimum.
O. Contact Region Traffic Operations for information regarding their standard practices.
P. Longitudinal channelization devices transversely at 1^o and 3-5 foot spacing) is an optional strategy to stop or move drivers traveling within the closed lane(s) but is not shown in the Typical TCP.
Q. The downstream taper of 59′-100′ is required on 1-lane, 2-way traffic configurations.
R. Duration of traffic holds for driveways, business accesses, and/or roadway approaches is listed as 5 minutes in this Typical Traffic Control Plan, but may be adjusted. Contact Region Traffic Operations for additional guidance.
S. When utilizing AFADs in Contracts, include the three Section 1-10 General Special Provisions for Specification, Measurement, and Payment.

**DESIGNER GUIDANCE:**
- A. Contact Region Traffic Operations to determine which Typical TCP(s) to utilize, as there are several variations available (or soon will be).
- B. These typical traffic control plans may be modified for site specific situations and/or WSDOT Region Traffic Operations standards practiced.

**Typical TCPs are not "Standard Plans".**
- C. See MUTCD Table 6-1 for additional temporary sign size information. Work zone signs are usually smaller than those used permanently.
- D. WAC 468-95-360 modifies MUTCD Table 6-1 "Recommended Advance Warning Sign Minimum Spacing". Sign spacing may be adjusted for field conditions based on engineering judgment. The Sign Spacing table is acceptable to use in Typical TCPs; however, site-specific traffic control plans should include actual sign spacing values (+/-) that have been verified in the field, on SR view, or via Google Maps.
- E. When positioned behind channelization devices, temporary signs should be mounted at 5′ minimum.
- F. The work zone design speed is typically the posted speed limit (or the work zone speed limit when in effect). For split speed limits (SPEED LIMIT 65 TRUCKS 80), use the higher 65 mph for work zone design. For this Typical TCP, the work zone design speed is based on the existing posted speed limit for sign spacing, channelization device spacing, buffer, and roll ahead distances.
- G. "Flagger tapers", also used for AFADs, are always 50′-100′ per closed lane with 6 vehicles minimum (10′-20′ spacing on the taper), regardless of the posted speed limit or lane width per MUTCD 6.10.2, Paragraph 15. Never use "L" for these tapers.
- H. Channelization devices types may be modified (vertical panel channelization devices prohibited). 26′ reflective traffic cones are recommended on flagger-controlled alternating traffic to provide access identification to maintain visibility for turning motorists. 36′ reflective traffic cones, 42′ tall channelization devices, or traffic safety drums may be used. Warning lights on channelization devices is being phased out in Washington. Contact Region Traffic Operations for information regarding their standard practices.
- I. Maximum channelization devices spacing table for tangents is based on WAC 468-95-301 and may always be reduced.
- J. Sequential arrow boards are prohibited at flagger tapers per WSDOT standard practice and per MUTCD Guidance TA-10.
- K. Per MUTCD Section GC.06, longitudinal buffer spaces are optional. Using longitudinal buffer spaces listed in MUTCD Table GC.2 is recommended as best practice per feasible, but may be adjusted based on engineering judgement. The Longitudinal Buffer Space table is acceptable in Typical TCPs; however, all-specific traffic control plans should include actual buffer distances that have been verified in the field, on SR view, or via Google Maps.
- L. The lateral buffer (transverse distance between open travel lanes and work area) is optional. No lateral buffer has been provided in these Typical TCPs due to the low speeds of alternating traffic. Actual work area limits may be modified.
- M. WSDOT best practice is to place a protective vehicle (PV) in the closed lane in advance of the work area for flagger-controlled alternating traffic, but if not published yet, they will be added in the future.
- N. When positioned behind channelization devices, temporary signs should be mounted at 5′ minimum.
- O. Contact Region Traffic Operations for information regarding their standard practices.
- P. Longitudinal channelization devices transversely at 1^o and 3-5 foot spacing) is an optional strategy to stop or move drivers traveling within the closed lane(s) but is not shown in the Typical TCP.
- Q. The downstream taper of 59′-100′ is required on 1-lane, 2-way traffic configurations.
- R. Duration of traffic holds for driveways, business accesses, and/or roadway approaches is listed as 5 minutes in this Typical Traffic Control Plan, but may be adjusted. Contact Region Traffic Operations for additional guidance.
- S. When utilizing AFADs in Contracts, include the three Section 1-10 General Special Provisions for Specification, Measurement, and Payment.